
 StreetGraphics Help Index

Commands

File Menu
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Page Menu
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View Menu
? Menu (Help)



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Server 
Connection

Starts a TCP/IP network connection as a server

Client 
Connection

Starts a TCP/IP network connection as a client

Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Send... Sends the active document through electronic mail.
Exit Exits StreetGraphics.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Redo Reverse previous undo operation
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



View menu commands

The View menu offers the following commands:

Status Bar Shows or hides the status bar.

File Toolbar Shows or hides the File toolbar

Drawing 
Toolbar

Shows or hides the Drawing toolbar

Edit Toolbar Shows or hides the Edit toolbar
Position 
Toolbar

Shows or hides the Position toolbar

Page 
Toolbar

Shows or hides the Page toolbar

Drawing Tool 
Settings

Shows or hides the Drawing Tool Settings toolbar

Drawing Tool 
Preview

Shows or hides the Drawing Tool Preview toolbar



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in StreetGraphics.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.sgr: StreetGraphics Document

Drives
Select the drive in which StreetGraphics stores the file that you want to open. 

Directories
Select the directory in which StreetGraphics stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    StreetGraphics suggests that 
you save changes to your document before you close it.    If you close a document without saving, you 
lose all changes made since the last time you saved it.    Before closing an untitled document, 
StreetGraphics displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, StreetGraphics displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    StreetGraphics displays the Save As dialog 
box so you can name your document. 

To save a document with its existing name and directory, use the Save command.



Send command (File menu)

Use this command to send the active document through electronic mail.    This command presents a mail 
window with the active document attached to it.    You may then fill out the To: field, Subject: field, etc., and 
add text to the body of the message if you wish.    When you are finished you may click the "Send" button 
to send the message.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    StreetGraphics adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your StreetGraphics session.    You can also use the Close command on the 
application Control menu.    StreetGraphics prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.    The Undo command changes to Can't Undo on the menu if you 
cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

Redo an undone command.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in StreetGraphics, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in StreetGraphics,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    StreetGraphics displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named the 
document, StreetGraphics displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the StreetGraphics window.    To display or hide the status bar, 
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using StreetGraphics and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of StreetGraphics.



Context Help command 

Use the Context Help command to obtain help on some portion of StreetGraphics.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then 
click somewhere in the StreetGraphics window, such as another Toolbar button.    The Help topic will be 
shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the StreetGraphics window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    StreetGraphics determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    StreetGraphics determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Color dialog box

Selects a color.



Modifying the Document

Use the available tools to modify the document.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Update command (File menu)

Update the document of the calling application.



Save Copy As... command (File menu)

Save the current document in a file.



Embedded Object Resize Bar

Resize the embedded object.



  





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that StreetGraphics is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.





Basic principles

Purpose of StreetGraphics

The typical StreetGraphics user
Variable width lines

Line rendering

Custom brushes

Color Blends

Transparency

Effects

Bitmaps

Bitmap processing

Network drawing



Purpose of StreetGraphics

Drawing programs available today can be classified in two categories, the "paint" category and the "draw" 
category.

Painting programs are appreciated for their capability of producing rich images: the user 
can work with various brushes and apply image processing filters to bitmaps. But even if they are the best 
tools available to get high quality pictures, painting programs present many important drawbacks. First, 
they force the user to work at a pre-determined resolution (the resolution is chosen when the image is 
created), second, they offer weak tools (or no tools at all) to create and modify geometric shapes: with a 
paint program, modification means erasing a portion of an image, repainting it, and then patching around 
it to hide side effects of the manipulation.

Drawing programs are a lot more flexible. Anything that you draw can be modified at any time 
during the creation process. The resolution of an image created with a "draw" is independent of the 
image, so pictures can be edited on screen or printed at different resolutions. The major problem with 
"draw" programs is that they only allow to create flat and very precise images. For many people, who 
need rich images, this problem is important enough to make them use painting programs for many tasks 
that would be a lot easier with a draw. Artists will struggle with inappropriate tools to get the graphical 
result they are looking for.

StreetGraphics tries to close the gap between Draws and Paints. Like with a draw, all graphic 
objects are vectorial and can be modified at any time. Like a paint, StreetGraphic has its own rendering 
system, allowing to create rich images with transparency, bitmaps, text, soft edged shadows, variable 
width lines, color blends, ect... But everything is resolution indepedent, and the display resoltion or the 
output resolution can be changed at any time for greater flexibility and ease of use.

StreetGraphics can be used very effectively as a standalone program, but is also an 
indispensable complementary tool for any existing graphic toolkit.



The typical StreetGraphics user

StreetGraphics can be useful to artists willing to produce printed or electronic documents with a rich 
rendering. For instance, it can be used to design logos or background tiles for web pages, or to produce 
printed images with transparent bitmaps, freehand drawing, geometric shapes, and text. With its 
network teamwork feature, StreetGraphics can also be seen as an interesting experimentation 
tool.



Variable width lines

With StreetGraphics, any line can have a tapered shape. Width control is done from a selection of 
shapes, joins, and closing butts.



Line rendering

All filling options available for closed shapes (colors, bitmaps, tiles, color blends, ect...) can also be 
applied to lines, giving the user more artistic freedom.



Custom brushes

There are two different options to render lines with StreetGraphics. With the first option, a line is rendered 
like an ordinary closed shape (all filling options available for a closed shape are also available for shape 
outlines and for open lines). With the second option, a line is rendered with a custom brush. This 
rendering technique uses a shape (the brush) which is moved along the path of the line to create 
an artistic effect. Combining brushes with transparency can produce impressive effects. Brushes can 
also be used in the calligraphic mode. In this mode, the brush is stretched along the path of the line.



Color Blends

A color blend specifies the blending of two colors (or two bitmaps) in an object to be rendered. Three 
geometric blendings can be used: linear, elliptic, diamond. It is also possible to use a bitmap as a 
blend, in which case darker shades will be mapped to the primary color, and lighter shades to the 
secondary color. There are two different ways to use a bitmap to blend colors. In the first, the bitmap is 
used as a standalone image. In the second, the bitmap is tiled to produce a pattern.



Transparency

Transparency is an omnipresent concept in StreetGraphics. Bitmaps and colors can be seen as "color 
sources" and each color source has its own transparency level. The higher the transparency level, 
the more the background color will show through the object. When a blending is specified to mix two 
different colors, each color can have its own transparency level. A blend of two colors with a different 
transparency level will give an object of variable opacity.



Effects

The result of applying a color to an object placed over a given background, is determined by the selected 
color (which can also be a bitmap), by the transparency level of the color, and by the selected effect. The 
effect will determine how the color will be applied to the background. Available effects are :

Assign : uses the color in a traditional fashion
Filter : limits the RGB intensities of the background to the selected color
Reverse : reverses the background
Lighten : lightens the background
Darken : darkens the background
Contrast + : increases the contrast
Contrast - : decreases the contrast



Bitmaps

Bitmaps are not considered by StreetGraphics as a special type of graphical object, but like a 
particular type of color source, so any object that can be rendered with an ordinary color can also 
be rendered with a bitmap. Any bitmap can be used as a standalone image, or as a tile to produce tiled 
patterns.

There are two different ways to integrate a bitmap to a document. The first way is to import an 
image from a file. At the present two file formats are supported, BMP and JPG. The second way is to 
generate a bitmap from a portion of the current vectorial drawing. Someone can ask wy such a thing 
needs to be done, since the image is already available in vectorial form in the same document. In 
practice, this operation is very useful because it allows to generate different effects like soft edged 
shadows, bitmap blends, textures. These effects are achieved through the use of bitmap processing 
operations.



Bitmap processing

Various bitmap processing operations are available (smoothing, thresholding, reversing, noise adding), 
and can be applied to any bitmap. Bitmap processing can be used to create soft edged objects or 
shadows (basically, the technique consists in creating a mask from an object, in smoothing the mask, and 
in using it as a color blend with a totally transparent secondary color).



Network drawing

StreetGraphics allows many users to work on a same document at the same time through a TCP/IP 
network connection. One participant must establish a server connection. The others    can then establish 
client connections and start working on the same project. A fast network (LAN) is needed for this 
operation to perfrom well.



How To

How to display a bitmap

How to cut out a bitmap

How to display a soft edged bitmap

How to display a soft edged shadow

How to create and use a brush

How to select an object through a transparent object

How to copy attributes from an object to another object

How to use plugin filters



How to display a bitmap

1. Using the Bitmap menu

The easiest way to display a bitmap (that has been imported or generated), is to call the "Bitmap-
>Display..." function. This function will display the bitmap in a rectangle. The proportions of the rectangle 
will respect the proportions of the bitmap.

2. Using the Wizard menu

The "Wizard->Display a bitmap in an object" function will let you select a bitmap and display it in the 
currently selected objects. The selection rectangle will determine the position of the bitmap.

3. Using the Drawing Tool Settings toolbar

Here we give a procedure that can be followed to display a bitmap using the "Drawing Tool Settings" 
toolbar. This procedure is not a "magic trick" of any kind. When you deal with bitmaps, remember that for 
StreetGraphics, a bitmap is a "color source" (a source of colors that can be used to render an object). The 
only difference between a bitmap and a flat color, is that the bitmap has a position (if the position of the 
bitmap and the position of the shape do not match the bitmap is not visible or only partially visible). So 
displaying a bitmap "manually" consists in three steps: a) selecting a bitmap color source, b) applying it to 
the shape, c) reposition the bitmap if necessary (using the "Bitmap->Fit" menu command).

1. Import the bitmap by calling the Bitmap->Import command
Calling Bitmap->Import will display the importation dialog. At this time, an existing bitmap file must 

be selected. BMP and JPG formats are supported.
(It is also possible to generate a bitmap from selected strokes with the Bitmap->Generate Bitmap 
command)

2. Draw a rectangle or any other closed shape
The bitmap can be used to fill a rectangle or any other shape. Here the rectangle can be created 

with the Rectangle tool. The color "Type" (in the Fill pane of the Drawing Tool Settings toolbar) should be 
"Color" when the bitmap is first created (it will be changed to Bitmap later in the process).

3. Select the Fill pane
The Fill pane of the Drawing Tool Settings toolbar is selected by activating its tab.

4. Color->Type->Image Bitmap
As stated before, the current Color->Type should be "Color" and the rectangle should be 

rendered in plain color. Now it is time to choose "Image Bitmap". A selection button, labeld "Select..." 
should appear on the right side of the combo box (NOTE: if this button is grayed, make sure that at the 
top of the pane the "24 bits" radio button is checked). The "Auto Move" checkbox can be checked to 
ensure that the image will move with the rectangle. Bitmap transparency can be set with the transparency 
slider.

5. Click the Select button to choose the bitmap
The Bitmap Selection Dialog will be displayed. The imported bitmap (ref. step 1) can be selected.

6. Click the "<Apply Fill" (apply) button at the bottom of the Fill pane
The "<Apply Fill" button applies the attributes (bitmap, transparency, ...) to the object. The 



"<<Apply All" button which applies both line and fill attributes can also be used.

REMARK:
If after assigning a bitmap to a shape the shape becomes black (the bitmap can't be seen), the 
shape and the image may be misaligned. To "fit the bitmap to the shape", execute the Bitmap->Fit 
command or the Bitmap->Fit (line) command. Make sure that the Page->Real menu option is 
checked.



How to cut out a bitmap

Extracting a non rectangular portion of a bitmap is a frequently used operation when working on images. 
This operation can be realized easily with StreetGraphics. To be able to cut out a bitmap, you should 
know how to successfully display it. The procedure is described in How to display a bitmap.

1. Display a bitmap in a rectangle
First, we want to display the image on screen. To know how this can be done, consult How to 

display a bitmap. The Auto Move check box should be checked for the rectangle (in the Drawing Tool 
settings toolbar). Checking this check box will ensure that the resulting cutout is moveable and sizeable

2. Clear the selection (by clicking on the background)
The next step consists in using the curve editing tool. To prevent this tool from starting in the 

curve editing mode, we clear the selection by clicking on the background.

3. Select the Curve Drawing tool
The tool can be selected from the Tool->Selection menu command or from the Drawing toolbar. It 

can be useful to select a pen width of 0 before starting to use the tool.

4. Trace the selected outline (the outline should be closed)
The outline is traced with the curve drawing tool. The curve is closed by clicking the triangle 

manipulator under the first point.

5. Make sure that "Auto Move" is checked in the fill pane, and click on "<Apply Fill"
If the Auto Move checkbox of the fill pane is not checked, check it. Then click on the "<Apply Fill" 

button of the fill pane with the mouse. The cutout is now ready to be moved and handled independently 
(activate the Selection tool to do so).

6. Activate the selection tool (the arrow) and move the cutout

REMARKS:
1. If after assigning a bitmap to a shape the shape becomes black (the bitmap can't be seen), the 
shape and the image may be misaligned. To "fit the bitmap to the shape", execute the Bitmap->Fit 
command or the Bitmap->Fit (line) command. Make sure that the Page->Real menu option is 
checked.

2. The default position of a bitmap (relative to the shape) that is assigned to a shape, is computed 
from the bounding box of the shape and from the width of the outline around the shape. If the 
width is important, the bitmap will look cropped. To solve this problem, reduce the width of the 
outline, then call the Bitmap->Fit function. You can also place the bitmap manually by calling the 
Bitmap->Place Manually function.



How to display a soft edged bitmap

1. Using the wizard menu

The "Wizard->Create a soft edge shadow or mask" menu function helps you creating a soft edge bitmap 
in one single operation. First select a single object (in which the bitmap is currently displayed), then call 
the function. 

2. Using the Drawing Tool Settings toolbar

Sometimes it is useful to create an image which borders melt gradually in the background. This operation 
can be executed in a few steps with StreetGraphics. The general approach consists in creating a mask 
from the selected shape (the shape in which the bitmap is displayed), smoothing the mask, then use the 
smoothed mask as an Image Bitmap blend, with a fully transparent secondary color.

1. Select the object which borders should be softened
This can be done with the Selection tool.

2. Create a mask from this object
Execute the Bitmap->Generate Bitmap menu operation. The Generate Bitmap Dialog will be 

displayed. A width should be selected for the generated mask. It's not necessary for the width to be high 
to get good results (a value of 100 or 150 is generally enough because the bitmap will be interpolated). 
The "Selection Mask" radio button should be checked (this option produces a black and white mask for 
the selected objects). Any description can be written in the description field, fox example, "mask #1".

3. Process the mask
Execute the Bitmap->Bitmap Processing operation from the menu. The Bitmap Processing dialog 

will be displayed. The "mask #1" mask can be selected from the Bitmap combo box. The mask will be 
displayed in the preview window. The mask can be smoothed by selecting Smooth from the Processing 
list box, then by pressing Apply. Applying the Threshold operation the same way can help getting a 
cleaner smoothed mask.

4. Use the mask as a blend
In the Fill pane of the Drawing Tool Settings toolbar, select "Image Bitmap" in the combo box 

labeled "Type:". Click on the "Select..." button, the Bitmap Selection dialog will be displayed. Select "mask 
#1" in the Selection listbox, and check the Interpolate checkbox (this will enable bitmap interpolation). 
Back in the Drawing Tool Settings toolbar, check the "Auto move" checkbox.

5. Select a totally transparent color as secondary color, and press "<Apply Fill"
Before the new fill attributes can be applied to the shape, a totally transparent secondary color 

(Transp: 255) should be selected. Then apply the attributes using the    "<Apply Fill" button.

6. How to increase the smoothing
The smoothing can be increased by processing again the "mask #1" bitmap with the Bitmap-

>Bitmap Processing command.



How to create a soft edged shadow

1. Using the wizard menu

The "Wizard->Create a soft edge shadow or mask" menu function helps you creating a soft edge shadow 
in one single operation. First select the object, then call the function. Once the shadow is created, you 
can change its color with the "Drawing Tool Settings toolbar" (changing the primary color in the fill pane 
will change the color of the shadow). You can also reposition it with the mouse and put it under the 
original object by calling the "Manipulation->Order->To Bottom" function.

REMARK:
The shadow is a rectangle which uses a bitmap to blend two colors. The primary color is the color of the 
shadow, and the secondary color is a fully transparent color.

2. Using the Drawing Tool Settings toolbar

The same method used to create a soft edged bitmap can be followed to create a soft edged shadow. A 
plain color will be used instead of a bitmap as the color of the resulting shape. The procedure is explained 
in How to display a soft edged bitmap. 

REMARK (to read after following the steps described in How to display a soft edged bitmap): To improve 
the quality of the result, a plain rectangle can be used to display the generated mask. The mask will be 
used as a blend, the primary color will be the color of the shadow, and the secondary color will be a fully 
transparent color.



How to create a brush

A brush allows to draw lines with a richer rendering than standard lines. A brush can be created from any 
closed curve by calling Manipulation->Add Brush, and then selected from the Line pane of the Drawing 
Tool Settings toolbar. The following example shows how to create a brush from an ellipse.

1. Create an ellipse
Activate the Ellipse Drawing tool and create the ellipse using the mouse.

2. Activate the Selection tool
Activate the Selection tool and make sure the ellipse is selected.

3. Convert the ellipse to a curve
Execute the Manipulation->Create a curve function.

4. Create the brush
Make sure the curve is selected. Execute the Manipulation->Add Brush command from the menu.

5. Configure the brush
The brush should now be available from the Brush combo box of the Line pane of the Drawing 

Tool Settings toolbar. To use it, select it and check the Brush check box. The Density determines how 
close each repetition of the brush will be to each other (a value of 60 can be tried). The transparency can 
be set to a very high value (ex: 220) to get a nice result.

6. Use the brush
Select the freehand drawing tool and try the brush.



How to select an object through a tranparent object

When working with tranparent objects, it is not always easy to know which object is in front and 
which is behind. In this situation, the standard selection mechanism which selects the highest object 
accessible under the mouse,    is not always practical.

To solve this problem, tranparency selection can be activated, with the Page->Selection-
>Transparency menu command.The option will become checked in the menu. From that moment, it will 
be possible to select object through objects by transparency.

REMARK : Roughly, transparency selection selects the smallest object around the mouse position.



How to copy attributes from an object to another object

There is no menu command to copy attributes from an object to another. This operation can be executed 
easily by unchecking the Auto checkbox of the Drawing Tool Settings toolbar in the Line pane or in the Fill 
pane.

1. Select the source object

2. Uncheck the Auto checkbox in the Line pane or the Fill pane
Doing this disables the update of the pane when new object are selected.

3. Select the target object
The pane is not updated with the attributes of the target object.

4. Apply the attributes clicking on "<Apply Fill" or "<<Apply All" in the Drawing Tool 
Settings toolbar

5. Re check the Auto checkbox



How to use plugin filters

StreetGraphics accepts standard Plugin Filters (.8BF). The plugins must be compiled in 32 bits (16 bits 
plugins will not work), and use the most recent resource format (PiPL).

StreetGraphics will search for plugins in the directory specified by the Plugins variable of the Path section 
of the Street.Ini file. The default path is the plugin path of the installation directory.

Plugins can be started from the Bitmap Processing dialog. Plugins that are not compatible with 
StreetGraphics will not be shown. Some of the visible plugins may not work properly (StreetGraphics 
implements most but not all of the standard server functions).



How to order the commercial version and how to get more 
information about the product

Strengths of the commercial version

How to get more information about StreetGraphics

How to order by credit card

How to order by check or postal order

License Agreement and Warranty



Strengths of the commercial version

Registering the product will give you access to the commercial (REGISTERED) version of 
StreetGraphics. The commercial version is similar to the base version and adds the following features:

- Registered version of the program
- CD with samples and manual (in electronic form) that explains advanced techniques with step by step 
procedures.



How to get more information about StreetGraphics

To get more information about StreetGraphics, you can:

- Consult the following Web page: http://www.odyssee.net/~hugow/

- Write by e-mail at the following address (*): hugow@odyssee.net

- Write by snail mail at the following address:

Orbis Tertius Informatique inc.
Succ. Mt-Royal

C.P. 263
H3P 3C5
Canada

(*) Correspondence in french or english. All your comments and suggestions about the software are 
welcome. Frequently asked questions (and answers) will be added to our web page.



How to order by credit card

Important

1. All orders are subject to the terms of the License Agreement
2. Credit card ordering available in english only (PsL, an american company, handles credit card 
orders).
3. Information about the product can NOT be obtained from the credit card ordering company, for 
the simple reason that this company does not have the information. To get more information, consult the 
how to get more information about StreetGraphics topic.

How to order by credit card (product # 14981) 

You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling 800-2424-PsL or 
713-524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470. You can also mail credit card 
orders to PsL at P.O. Box 35705, Houston, TX 77235-5705.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be 
directed to Orbis Tertius Informatique inc.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship the 
product directly to you.

Credit card order form

Prices guaranteed through June, 1997

Product # 14981

StreetGraphics ________ copies at $39 US each =  ___________
Shipping 
($4 US per copy in Canada and USA,
$6 US Overseas) +    ___________

Total =    ____________

Name : _____________________________ Date : ____________________
Company: _____________________________________________________
Address : ______________________________________________________
City, State, Zip : ________________________________________________
Country : ______________________________________________________
E-Mail address : _________________________________________________
Comments : ____________________________________________________



How to order by check or postal order

Ordering can be done by sending the order form and the check (in US$) or postal order (in US$) to the 
following address:

Orbis Tertius Informatique inc.
Succ. Mt-Royal

C.P. 263
H3P 3C5
Canada

Order form (when ordering by mail)

Prices are valid through june 1997

StreetGraphics ________ copies at $39 US per copy =  ___________
Shippinng and handling
($4 US per copy in Canada and in the USA,
$6 US overseas) +    ___________

Total =    ____________

Name : _____________________________ Date : ____________________
Company: _____________________________________________________
Address : ______________________________________________________
City, State, Zip : ________________________________________________
Country : ______________________________________________________
e-mail (optional) :_______________________________________________

Optional information:
PC Type: ___ 486 ___ Pentium    ___ P6    _____ Other : _________
Operating System: ___ Windows95    ___ NT3.51 ___ NT4
Graphics Adapter Type: ___ 256 colors ___ >256 colors    ____ 24bits
Type of docuement created with StreetGraphics: ____ Paper, ____ Electronic
Type of use: ____ professional, ___ hobby, ____student

Comments : _______________________________________________________
__________________________________________________________________
__________________________________________________________________



License Agreement and Disclaimer of Warranty

StreetGraphics © 1996 Orbis Tertius Informatique inc.

You must read carefully the terms and conditions of the License Agreement before you start using the 
software. Using the software implies that you have read, understood, and accepted the terms of the 
License Agreement. "License Agreement - UNREGISTERED VERSION" applies to users of the 
unregistered version of the software. "License Agreement - REGISTERED VERSION" applies to users of 
the registered version of the software.

License Agreement - UNREGISTERED VERSION

- This license Agreement applies to Users    of "StreetGraphics UNREGISTERED VERSION" (the 
software).

- This license Agreement permits you to use StreetGraphics UNREGISTRED VERSION for a 30 days 
evaluation period.
- This license Agreement permits you to duplicate and distribute free of any charge StreetGraphics 
UNREGISTRED VERSION, as long as all parts of the software are distributed in their original form
- This license Agreement does not permit you to sell rent or lease StreetGraphics UNREGISTERED 
VERSION.
- This license Agreement does not permit you to distribute StreetGraphics UNREGISTERED VERSION as 
a part of another software or hardware product.
- This license Agreement does not permit you to reverse engineer or modify the software

License Agreement - REGISTERED VERSION

- The license Agreement applies to Users of "StreetGraphics REGISTERED VERSION" (the software).

- You do not have the right to use the software if you do not own a license from Orbis Tertius Informatique 
inc or one of its resellers. Using StreetGraphics REGISTERED VERSION without owning a license is 
illegal.
- By using the software you are agreeing to be bound to the terms of the License Agreement. If you do not 
agree the terms of the agreement, promptly return the unopened software packet and the accompanying 
items to the place you obtained them for a full refund.
- The license Agreement permits you to use one copy of StreetGraphics REGISTRED VERSION on a 
single computer. The software is in "use" on a computer when it is loaded into temporary memory (i.e. 
RAM), or installed into permanent memory (e.g. hard disk or other storage device).
- The license Agreement permits you to duplicate the SOFTWARE for backup purpose only.
- The license Agreement does not permit you to sell, rent or lease StreetGraphics REGISTERED 
VERSION.
- The license Agreement does not permit you to distribute StreetGraphics REGISTERED VERSION as a 
part of another software or hardware product.
- The license Agreement does not permit you to reverse engineer or modify the software

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and software environments 
into which StreetGaphics may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS 



OFFERED.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. The user must assume the entire risk of unsing the 
program. ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT 
REPLACEMENT OR REFUND OF PURCHASE PRICE.



Closes the server connection



Freehand Drawing tool

The Freehand Drawing tool can be selected from the Tool->Freehand Drawing menu command, or from 
the Drawing toolbar (the Freehand Drawing tool is represented by a pencil). The Freehand Drawing tool 
allows to :

- Draw curves with the mouse

When the freehand drawing tool is selected, a new tool is added to the toolbar. This tool allows to set the 
freehand options through the freehand settings dialog.

Draw curves with the mouse

To draw a curve, click and hold the mouse button, drag the mouse, release the mouse button. A closed 
curve will be filled. A curve which starts at the end of the currently selected curve will be appended to it. 
Every stroke is automatically converted to a Bézier curve.

When drawing, the following keys allow to control the behavior of the tool:

CTRL: a) The stroke will not be appended to the currently selected curve. 
b) The drawn line will not be automatically closed and filled.

SHIFT: The stroke is converted to a single segment Bézier curve.



Selection Tool

The selection tool can be selected from the Tool->Selection menu command, or from the Drawing 
toolbar (the selection tool is represented by an arrow). The selection tool allows to :

- Select one or more objects
- Move the selection
- Drag and drop the selection
- Size, shear and rotate the selection
- Activate selection related commands in the menus

Select one or more objects

- To clear the selection, click on the background
- To select an object, click on it
- To add an object to the current selection, click on it while holding the SHIFT key
- To select one or more objects with a selection box, click on the background at the top left corner of the 
objects, drag to the bottom right corner of the objects (the selection box will be visible during this 
operation), then release the mouse button.
- To select an object under a transparent object, activate tranparency selection (Page->Selection-
>Transparency), then select the object.

Move the selection

- Click on the selection (hold the mouse button down), drag it, drop it.

When dragging (AFTER clicking on the selection), the following keys allow to control how the objects are 
moved:

CTRL: The object moves only horizontally or vertically.
SHIFT: Grid and guideline snapping is disabled while the key is pressed.

Drag and drop (OLE) the selection

- To drag and drop the selection, press and hold the CTRL key, click on the selection, drag it, drop it. The 
selection will be duplicated.

Size, shear and rotate the selection

- To size the selection use the square manipulators of the selection box. (REMARK: When a corner 
manipulator is used, CTRL maintains the proportions of the selected object)

- To shear the selection, use the oblique square manipulators of the selection box.

- To rotate the selection, use the circular manipulators of the selection box. Change the rotation center by 
dragging the X manipulator (by default, the X manipulator or rotation center is positioned at the center of 
the selection).

While dragging the manipulators, hold the following keys to modify the action :

SHIFT: Centers the transformation (the scaling is mirrored on both sides of the selection)



Activate selection related commands in the menus

You will notice that many menu commands become active only in selection mode. These commands 
operate on selected objects and can only be launched from the selection mode.

Example:
Manipulation->Order->Step Up, is active only when the selection tool is selected.



Allows to zoom in with the mouse. Zooming in will enlarge a portion of the drawing.



Allows to zoom out. Zooming out will restore the previous zoom level.



Zoom to show all objects.



Curve Drawing Tool

The Curve Drawing tool can be selected from the Tool->Curve Drawing menu command, or from the 
Drawing toolbar (the Curve Drawing tool is represented by a curve segment). The Curve Drawing tool 
allows to :

- Draw curves
- Edit curves
- Edit curves created with the Freehand Drawing tool

When the curve drawing tool is selected, curve editing tools will be added to the toolbar. These tools 
allow to perform editing operations on the selected curve.

Draw curves

Position the first point by clicking the mouse. Position the next points. At any time any point can be 
selected and edited using the control points. To close the curve click on the triangle at the start of the 
curve. To end the curve without closing it, click on the square at the end of the curve. You can pierce 
holes into a closed curve by : ( a. closing the curve )    b. starting to add additional points to the curve.

While dragging control points, the SHIFT key will smooth the current curve section, and CTRL will make it 
symmetrical. 

Curve editing tools can be used to :
- force a discontinuity on a point
- force smoothness on a point
- force symmetry on a point

- force a curve segment to be straight
- force a curve segment to be curved

- remove the selected point (points can only be removed one at a time)
- add a point on the curve with the mouse
- break the line under the selected point
- join two ending points

Edit curves

Once a curve is created, it can always be re-edited. Edition and creation are done the same way, with the 
same tool. To edit an existing curve, select it with the selection tool (the arrow), then activate the curve 
editing tool and edit the curve.

Edit curves created with the Freehand Drawing tool

Curved lines created with the Freehand Drawing tool (the pencil), can always be edited with the Curve 
Drawing tool. To do this, select the curve, then activate the curve drawing tool.



Text Drawing Tool

The Text Drawing tool can be selected from the Tool->Text menu command, or from the Drawing toolbar 
(the Text Drawing tool is represented by an A letter). This tool allows to :

- Create a text
- Change character spacing
- Position characters
- Edit a text
- Modify an existing text

When the text drawing tool is selected, text editing tools are added to the toolbar. These tools can be 
used to edit the selected text and to change the font of one or more characters.

Create a text

Select a position with the mouse, and click the left mouse button. The Text Editing dialog will be 
displayed. In this dialog, you can type your text, select the font, style, size, and alignment.

When the text is created, it is diplayed with two control points : the square control point (used to 
deselect the text), and the circle control point.

Change character spacing

The round control point can be dragged to change inter-character spacing.

Position characters

Whenever the two control points are displayed (the square and the circle), characters can be individually 
selected. To select an individual character, click on it. To select two characters, hold SHIFT and click on a 
second character.

When one or more characters are selected, it becomes possible to scale/rotate/shear/move them 
(with the control points of the selection box), and to select a new font for them (with the font selection tool 
of the toolbar).

Edit a text

Whenever the two control points are displayed (the square and the circle), the text can be edited. To edit 
the text, click on the text editing button.

Modify an existing text

To edit an existing text, select it with the selection tool, then activate the text editing tool.



Displays the page settings dialog. Allows to select the format of the edited page.



Selects the Wire Frame rendering mode. The document is rendered with black lines (one pixel wide) on a 
white background.



Selects the Vectorial rendering mode. The document is rendered using GDI functions only. Transparency 
and bitmaps are not displayed.



Selects the Real rendering mode. Bitmaps and transparency are supported.



Displays the Options dialog box. The dialog box allows to configure the display (to improve speed or 
quality of the display). Printing options can also be set from the Options dialog box.



Sizes the display so the whole page is visible.



Starts a server connection. To start a drawing session on a TCP/IP network, one participant must start a 
connexion as a server, and the others join the session as clients.



Starts a client connection. To start a drawing session on a TCP/IP network, one participant must start a 
connexion as a server, and the others join the session as clients. It makes sense to start a client 
connection only if you know the IP address (and service #, usually 20000), of a computer currently 
runnging StreetGraphics in server mode.



Exits and asks the user to save modified documents.



Groups the selected objects. When objects are grouped, they can be manipulated as one single object 
(any sizing, moving, ..., of the group will be applied to all the grouped objects).



Combines the selected curve into one curve. The resulting object is not a group but a complex curve (that 
can be edited with the curve drawing tool).



Breaks a group. All its components will become individually manipulable.



Increases the display order of selected objects. The higher the display order of an object, the higher the 
number of other objects it will hide.



Decreases the display order of selected objects. The higher the display order of an object, the higher the 
number of other objects it will hide.



Puts selected object at the top of the list so that they will hide everything else.



Puts selected object at the bottom of the list so that they will be hidden by everything else.



Aligns selected objects on their right. The object at the back of the selection will not be moved. Other 
selected objects will be moved to ensure they are all aligned to its right.



Aligns selected objects on their left. The object at the back of the selection will not be moved. Other 
selected objects will be moved to ensure they are all aligned to its left.



Aligns selected objects on their horizontal center. The object at the back of the selection will not be 
moved. Other selected objects will be moved to ensure they are all aligned to its horizontal center.



Aligns selected objects on their vertical center. The object at the back of the selection will not be moved. 
Other selected objects will be moved to ensure they are all aligned to its vertical center.



Aligns selected objects on their top. The object at the back of the selection will not be moved. Other 
selected objects will be moved to ensure they are all aligned to its top.



Aligns selected objects on their bottom. The object at the back of the selection will not be moved. Other 
selected objects will be moved to ensure they are all aligned to its bottom.



Tiles selected objects horizontally.



Tiles selected objects vertically.



Tiles selected objects in an ascending diagonal.



Tiles selected objects in an descending diagonal.



Displays or hides the grid.



Enables or disables the grid.



Configures the grid.



Enables or disables guidelines.



Reverses the order of selected objects. The higher the display order of an object, the higher the number 
of other objects it will hide.



Displays or hides guidelines.



Places an horizontal guideline.



Places a vertical guideline.



Displays or hides    the Drawing Tool Settings toolbar. This toolbar allows to select rendering attributes of 
objects beeing drawn.



Forces the curve to be discontinuous at a given point.



Forces the curve to be smooth at a given point.



Forces the curve to be symmetrical at a given point.



Sets a straight segment between two points.



Sets a curved segment between two points.



Deletes the selected point from the curve.



Allows to add a point on the curve with the mouse.



Opens the curve at the selected point.



Ties the two selected points and closes the curve between them.



Displays or hides the Edit toolbar.



Enables or disables edge selection. When edge selection is enabled, objects can only be selected by 
their edges.



Enables or disables transparency selection. When transparency selection is enabled, objects can be 
selected through other objects "hiding" them. This selection mode can be useful when a lot of transparent 
objects are displayed, and the display order is not evident.



Imports a bitmap. The imported bitmap is not displayed on screen, but is available as a filling color.



Creates a brush. The brush becomes available to render lines. Brushes can only be created from closed 
Bézier curves.



Deletes a bitmap or a brush. The deleted bitmap or brush will no longer be available to render objects.



Displays or hides the Drawing Tool Preview toolbar. This toolbar shows how the currently selected 
rendering attributes will look once assigned to an object.



Displays a bitmap in a rectangle (the rectangle will be automatically created)



Displays a bitmap in the currently selected object. The selection rectangle will determine the position of 
the bitmap.



Creates a bitmap from the currently selected objects. The bitmap is then used as color source for the 
currently selected objects. (using the "Bitmap->Bitmap Processing..." function will then let you alter the 
rendering of the objects and create interesting effects).



Creates a soft edge shadow from the selected objects. The shadow is a rectangle which uses a bitmap to 
blend two colors. The primary color is the color of the shadow, the secondary color is fully transparent.



Deletes the selected objects.



Pastes an image as a bitmap



Selects a normal line



Selects an air brush line.



Selects a calligraphic line



Selects a local blend. A local blend is applied to all repetitions of the brush in an airbrush line



Sets the line behind fill option. When the line is rendered behind the fill it can be partially hidden. 



Applies the current options to the selected line



Automatically updates the toolbar when a new object is selected.



Rectangle Drawing Tool

The Rectangle Drawing tool can be selected from the Tool->Rectangle menu command, or from the 
Drawing toolbar (the Rectangle Drawing tool is represented by a rectangle). This tool allows to :

- Draw rectangles

Draw rectangles

To draw a rectangle, click the mouse at the top left corner of the rectangle. While holding the mouse 
button, drag to the bottom right corner, then release the button. The rectangle will be created.

When drawing the rectangle, the following keys can be used :

CTRL:    To force the rectangle to be square
SHIFT: To force the rectangle to be centered

REMARK:

A rectangle is a Bézier curve. To edit a rectangle with the Curve Drawing tool, select the rectangle, then 
activate the Curve Drawing tool.



Ellipse Drawing tool

The Ellipse Drawing tool can be selected from the Tool->Ellipse menu command, or from the Drawing 
toolbar (the Ellipse Drawing tool is represented by an ellipse). This tool allows to :

- Draw an ellipse
- Edit an ellipse
- Modify an ellipse

When the ellipse drawing tool is selected, ellipse editing tools are added to the toolbar.

Draw an ellipse

To draw an ellipse, click the mouse at the top left corner of the ellipse. While holding the mouse button, 
drag to the bottom right corner, then release the button. The ellipse will be created.

When drawing the ellipse, the following keys can be used :

CTRL:    To force the bounding rectangle to be square
SHIFT: To force the bounding rectangle to be centered

Edit an ellipse

Once an ellipse is created, the ellipse editing mode is activated. The small control points can be used to 
open the ellipse (i.e. to create a pie). The large control points allow to change the horizontal and vertical 
dimensions of the ellipse.

Two other tools are available (these tools are added to the toolbar when the ellipse tool is 
selected). The first one transforms a filled ellipse to an outlined ellipse (an ellipse that can be outlined but 
not filled). The second one swaps the two angles of the ellipse.

The square control point deselects the current ellipse. To draw another ellipse, click on the square 
control point.

Modify an ellipse

To modify an ellipse, select it, then activate the Ellipse Drawing tool.

REMARK:

An ellipse is not a Bézier curve. To edit an ellipse with the Curve Drawing tool, it must be converted to a 
curve with the Manipulation->Create a Curve command. This command is only available when the 
Selection tool is active.



Displays the text editing dialog.



Displays the font selection dialog.



Toggles the display mode of an ellipse from filled to outlined.



Swaps the angles of an ellipse.



Displays or hides the ruler.



Converts a text or an ellipse to a curve.



Convert a complex Bézier curve to multiple simple Bézier curves.



Displays the bitmap generation dialog. This dialog allows to create a bitmap from selected objects.



Displays the bitmap processing dialog.This dialog allows to apply various image processing operations to 
a bitmap.



Fits the primary color bitmap to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible.



Fits the secondary color bitmap to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible. The bitmap will placed to fit the bounding rectangle of the 
selected object.



Fits the blend bitmap to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible. The bitmap will placed to fit the bounding rectangle of the 
selected object.



Sets the proportions of the object from the proportions of the bitmap selected as primary color.



Sets the proportions of the object from the proportions of the bitmap selected as    secondary color.



Sets the proportions of the object from the proportions of the bitmap selected as blend.



Allows to place manually (with the mouse) the bitmap selected as primary color. When a tiled bitmap 



Allows to place manually (with the mouse) the bitmap selected as secondary color.



Allows to place manually (with the mouse) the bitmap selected as blend.



Fits the primary color bitmap (line rendering) to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible.



Fits the secondary color bitmap (line rendering) to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible.



Fits the blend bitmap (line rendering) to the size of the selected object.

When a bitmap is selected as "color source" for a given object but is not visible inside the object (the 
object is black), it is possible that the object and the bitmap are misaligned. This command will 
reposition the bitmap to make it visible.



Sets the proportions of the object from the proportions of the bitmap selected as primary color (line 
rendering).



Sets the proportions of the object from the proportions of the bitmap selected as secondary color (line 
rendering).



Sets the proportions of the object from the proportions of the bitmap selected as blend (line rendering).



Allows to place manually (with the mouse) the bitmap selected as primary color (line rendering).



Allows to place manually (with the mouse) the bitmap selected as secondary color (line rendering).



Allows to place manually (with the mouse) the bitmap selected as blend (line rendering).



Displays the bitmap exportation dialog.



Displays the rotation dialog.



Displays the scaling dialog.



Displays or hides the Drawing toolbar.



Displays or hides the Position toolbar.



Displays or hides the Page toolbar.



Updates the display.



Displays the importation dialog (for .sgr files).



Shows the number of selected objects.



Calls the Background Removal Wizard



"About" dialog

Gives information about StreetGraphics.



"Options" dialog

Sets display options. Display options control rendering speed, rendering precision, and a few other 
settings involved in printing and copying data to the clipboard.

Display (real)

Coarse: Selects a fast but coarse display resolution in real display mode.
Normal: Selects normal display resolution in real display mode.
Fine: Selects fine but slow display resolution in real display mode.

Display bitmaps: Enables bitmap display in real mode.
Interpolate bitmaps: Enables bitmap interpolation in real mode.
Use blends: Enables blending in real mode.

Display (gdi)

Emulate real blends for lines: Enables the emulation of blends for lines in GDI preview mode.
Emulate real blends for shapes: Enables the emulation of blends for shapes in GDI preview mode.

Clipboard

GDI Objects Only: Only GDI rendered objects should be copied on the clipboard metafile.

Grid

Number per cm in X: Number of grid graduations per cm horizontally.
Number per cm in Y: Number of grid graduations per cm vertically.
Show Grid: Displays or hides the grid
Use Grid: Enables or disables the grid

Print

Pixels / page in X: Number of pixels to use horizontally to print real objects. This value sets the 
precision and the speed of printing. A value of 2000 gives a fine output on a 
standard laser printer. A value of 1000 is enough for a fast and reasonably good 
printing.

Interpolate all bitmaps: Forces the interpolation of all bitmaps during printing. Bitmap interpolation 
reduces the pixel jaggies of enlarged bitmaps (the output is smoothed between 
pixels).



Client Connection dialog

Starts a TCP/IP client connection.

Client Name: Any name can be typed here. This name will indentify you to other users.

Server IP Addres: IP address of the computer connected as a server.

Server Port: Socket number used by the server.



Server Connection dialog

Starts a server TCP/IP connection.

Server Name: Any name can be typed here. This name will indentify you to other users.

Max. Number of Clients:Maximum number of clients (including the server) that will be allowed to join the 
session.

Accept clients manually:When selected, a message box will be displayed each time a new client tries to 
join the session. The message box can be used to accept or refuse the client.

Server Port: Socket number used for the connection. This number should be known by any 
user trying to join the session.



Chat pane

Allows to chat with other participants during a network session.

Send: Sends the current message
Message edit box: Usable to edit the current message

To : (all) : Selects all participants as destination for the message.
Destination listbox: Selection of destinations

Received : (erase) : Erases currently displayed messages



Drawing Tool Settings toolbar (pane selection toolbar)

Allows to select the active pane: line, fill, preset, or chat.



Line Style Toolbar

The line style toolbar allows to select the attributes of lines. In versions previous versions of Street 
(<1.06), line attributes could be changed with the tool settings pane. Now the tool settings pane is 
reserved to color attributes while line attributes are controlled by the line style toolbar.

Line type selection

The first three buttons allow to select the line type. Three types are available: straight, air, and 
calligraphic.

Preset

The preset combo box allows to select predefined line attributes.

Line Width

W1 : Selects first width.

W2 : Selects second width. This width is used when a tapered line shape is selected.

Taper selection: Selects the shape of the line.

Join: Selects the type of join between ligne segments.

Butt: Determines how open ended lines are rendered.

Brush

Brush (checkbox): Enables brush rendering

Brush combo box: Allows to make a selection from available brushes

Density: Controls the repetition frequency of the brush pattern

Local Blend: Enables the application of the blend to each repetition of the brush pattern.



Line and Fill Tool Settings Panes

Sets the line and fill attributes. The "Presets..." button allows to select from predefined attributes.

Presets: This combo box allows to select predefined color attributes.

Rendering Type

Invisible : the object is not rendered.

GDI : the object is always rendered in vectorial mode (useful for text) 

24 Bits : the object is rendered in real mode (transparency and bitmaps are only 
supported in this mode)

Blend

Selects the type of blending (the blending is the way that the primary color and the secondary color are 
used when an object is rendered).

None: The primary color is used as a flat color. The effect is visble in vectorial preview, 
or in real rendering. It can be applied to 24 Bits objects and to GDI objects.

Line: A linear variation from the primary color to the secondary color is used. The angle 
can be selected. The effect is visible in vectorial preview or in real rendering. It 
can be applied to 24 Bits objects and to GDI objects.

Ellipse : An elliptic variation from the primary color to the secondary color is used. The 
center of the ellipse can be spcified using the %X an %Y values (50,50 is the 
center of the ellipse). The effect is visible in vectorial preview or in real rendering. 
It can be applied to 24 Bits objects and to GDI objects.

Tiled Bitmap: Uses the intensity of a bitmap's pixels to blend the two colors (black means 100% 
primary color, white means 100% secondary color). The bitmap is tiled and 
cannot be rotated or sheared. The effect is only visible in real rendering. It can 
only be applied to 24 Bits objects.

Image Bitmap : Uses the intensity of a bitmap's pixels to blend the two colors (black means 100% 
primary color, white means 100% secondary color). The bitmap is used as single 
image, and can be rotated and sheared. The effect is only visible in real 
rendering. It can only be applied to 24 Bits objects.

Color

Primary and Secondary:    The two colors used by the blend (when blending mode is none, only the 
primary color is important).

Transp. : Selects the transparency: 0 means full opacity, 255 means full transparency.

Effect: Selects the way that the selected color is combined with the background. Assign 
applies the color directly, Reverse reverses the background, Filter limits the 



background to the color, Lighten lightens the background, Darken darkens the 
background, Contrast + increases contrast, Contrast - decreases contrast

Type : Selects the color source. Color specifies a plain color. Tiled bitmap specifies a 
bitmap that should be tiled. Image Bitmap sepcifies a bitmap that should not be 
tiled.

Sélect : Displays the bitmap selection dialog.

Auto Move: Forces the bitmap to move when the object is moved.

Apply Buttons

<<Apply All: Applies both line and fill settings at the same time.

< Apply Line: Applies only the attributes of the current pane.

< Apply Fill: Applies only the attributes of the current pane.

Auto: Enables automatic updating of the current pane's content when a new object is 
selected.

To Line or To Fill: Copies filling attributes to line attributes, or line attributes to fill attributes.



Bitmap Selection dialog

Selects a bitmap to be used as a blend or a color source.

Preview: Displays the selected bitmap. Allows to crop (select the region of interest) with 
the mouse.

Sélection : Allows to select a bitmap.

Left: Left limit of the selected region

Top: Top limit of the selected region

Right: Right limit of the selected region

Bottom: Bottom limit of the selected region

Interpolate: Enables bitmap interpolation. An interpolated bitmap looks smooth and 
continuous even when it is enlarged, because values are computed between the 
pixels.



Delete Bitmap or Brush dialog

Allows to delete a bitmap or a brush from the document's resources list.

Preview: Displays the selected resource
Delete: Shows the list of available resources.



Drawing Tool Preview toolbar

This toolbar shows how the currently selected attributes will be rendered.

Shape: Shows the shape of the line

Line: Shows the color of the line in the real rendering mode. On the left, the color is 
applied on a white background. On the right it is applied on a black background. 
Bitmaps are not represented.

Fill color: Shows the fill color in the real rendering mode. On the left, the color is applied on 
a white background. On the right it is applied on a black background. Bitmaps are 
not represented.



Edit Text dialog

Allows to edit a text.

Edit box: Allows to edit the text

Fonts: Allows to select a font

Style: Allows to select the style of the font

Size: Allows to select the size of the font

Preview: Shows the currently selected font

Alignment : Sets the alignment (the alignment is only visible in the document)



Generate Bitmap dialog

Allows to generate a bitmap from selected objects.

Width: Width of the bitmap in pixels

Auto Height: Enables automatic height

Height: Height in pixels

Selection: Creates a bitmap from selected objects. The objects are rendered on a white 
background.

Selection rectangle: Creates a bitmap from the bounding rectangle of the selection.

Selection mask: Creates a bitmap from selected objects. The objects are rendered in black on a 
white background. Groups cannot be used to generate masks.

Description: Description of the bitmap. Allows to identify the bitmap in listboxes whenever a 
bitmap should be selected.



Bitmap Processing dialog

Applies image processing operators to bitmaps.

Bitmap: Selects the bitmap to process

Processing: Selects the type of processing

Apply: Selects the appropriate image processing operator

Setup: Configures the currently selected operator

Reset: Clears all transformations on the currently selected bitmap



Smooth setup dialog

Accessible from the Bitmap Processing dialog, this dialog allows to configure the bitmap smoothing 
operator. This operator can be used to blur a bitmap.

Intensity determines the strength of the effect:
X: Selects the horizontal smoothing intensity
Y: Selects the vertical smoothing intensity

Channels determines the channels which will be affected:
Red: Enables processing in the red channel
Green: Enables processing in the green channel
Blue: Enables processing in the blue channel

Edges selects a way of handling the borders of the image:
Connect: Connect borders to the opposite borders
Spread: Extends the color at the border
White: Use white outside the borders
Black: Use black outside the borders



Threshold setup dialog

Accessible from the Bitmap Processing dialog, this dialog allows to configure the bitmap thresholding 
operator. This operator can be used to clip intensity outside a given range, and to spread the result over 
another range.

Keep determines the range of intensities to be kept.
From: Darkest intensity to be kept (min: 0)
To: Brightest intensity to be kept (max: 255)

Spread determines the range of redistribution.
From: Darkest intensity of the resulting bitmap (min: 0)
À : Brightest intensity of the result (max: 255)

Channels determines the channels which will be affected:
Red: Enables processing in the red channel
Green: Enables processing in the green channel
Blue: Enables processing in the blue channel



Intensity setup dialog

Accessible from the Bitmap Processing dialog, this dialog allows to configure the intensity of an effect.

Intensity: Sets the intensity level

Channels determines the channels which will be affected:
Red: Enables processing in the red channel
Green: Enables processing in the green channel
Blue: Enables processing in the blue channel



Bitmap Exportation dialog

Allows to export the document, selected strokes, or a resource bitmap to a bitmap file. Supported formats 
are .bmp and .jpg. Format selection is determined by the extension of the selected output file.

Document : Allows the exportation of the document
Sélection : Allows the exportation of selected strokes
Bitmap : Allows the exportation of a bitmap resource (which should be selected in the 

listbox)

Size determines the size in pixels of the output bitmap
Width: Width in pixels
Auto Height: Enables automatic height computation
Height: Height in pixels

File: Filename of the bitmap file. The format is determined by the extension (use .bmp 
to generate a Windows BMP file, and .jpg to generate a JPEG file).

Select: Selects the output file with a file browser



Rotation dialog

Allows to rotate selected objects.

Angle : Rotation angle (degrees, + = counterclockwise)
Keep Original: Allows to keep the original objects
Repeat: Repeats the operation



Scale dialog

Allows to scale selected objects.

Horizontal (%) : Percentage in X
Vertical (%) : Percentage in Y

Keep Original: Allows to keep the original
Repeat: Repeats the operation



Freehand Settings Dialog

The freehand settings dialog allows to configure the freehand drawing tool. The freehand drawing tool 
can be configured to control color attributes while drawing. The following basic modes are available on all 
computers

None No control
Speed Pointer speed controls the intensity of the effect
Random A random value controls the intensity of the effect

The following modes are available on computers with wintab32 compliant pressure sensitive tablets:

Pressure The intensity of the effect is controlled by pen pressure
Tilt The intensity of the effect is controlled by pen tilt (angle of the pen from vertical)
Tilt angle The intensity of the effect by tilt angle (i.e. North East South West)

Any of the following attributes can be controlled:

Width The width of the line is increased or decreased by the control
Transparency The transparency of the line is increased or decreased by the control
Brightness The control has an effect on the brightness and the darkness of the line



Apply Image Processing To Selection Wizard

This wizard lets you create a bitmap from selected objects, process, and display this bitmap in the objects 
in one single operation. This operation does not immediatly change the aspect of the selected object, but 
you will notice that they all use a bitmap (the same bitmap) as a color source. 

Width The Width of the bitmap (in pixels)
Auto Height Force auto-height
Height The height of the bitmap (in pixels)
Description A name to give to the bitmap

Create From

Selection Create the bitmap from selected objects only
Selection Rectangle Create the bitmap from all the objects in the selection rectangle
Selection Mask Create a mask (black and white) from the selected objects

Use bitmap for

Lines Use the bitmap as color source or blend for the lines
Fill Use the bitmap as color source or blend for the closed shapes

Assign bitmap to

Blend Use the bitmap to blend two colors
Primary color Use the bitmap as a primary color
Secondary color Use the bitmap as a secondary color

Processing... Apply image processing functions to the bitmap



Create Soft Edge Shadow wizard

This wizard will create a soft edge shadow for the selected objects.

Create Mask

Width The width of the mask (the mask is a bitmap that will be created by the wizard)
Auto Height Forces automatic height computation
Height The width of the mask
Description A description of the mask
Bleed A size (in 1/100 mm) that should be added to the selection rectangle to allow the 

smoothing to propagate
Auto Smooth Forces automatic smoothing (extra smoothing can be added with the Bitmap-

>Image Processing menu command)



Display Bitmap wizard

This wizard will display a bitmap in one ore more selected objects.

This dialog lets you select predefined rendering attributes like air brush or wood texture.

Use bitmap for

Lines Use the bitmap as color source or blend for the lines
Fill Use the bitmap as color source or blend for the closed shapes

Assign bitmap to

Blend Use the bitmap to blend two colors
Primary color Use the bitmap as a primary color
Secondary color Use the bitmap as a secondary color

Use Bitmap As

Tile The bitmap will be tiled in the objects (X tiles horizontally and Y tiles vertically)
Image The bitmap will be used as an image (not tiled)

Select Bitmap Selects a bitmap from available bitmaps



Background Removal Wizard

This wizard lets you select a color from a bitmap and create a mask. The mask will be used to make the 
selected color transparent (the mask will automatically be selected as a bitmap blend with a fully 
transparent secondary color).

Use the mouse to pick a color in the original bitmap

The tolerance value lets you control how close a color has to be from the selected color to become 
transparent.



Manipulation Menu Commands

The Manipulation menu proposes the following commands:

Group Group selected objects

Ungroup Ungroup the selected group

Link Link selected curves
Unlink Unlink the selected complex curve
Rotate Rotate selected objects
Scale Scale selected objects
Order Submenu allowing to change the display order of selected objects
Align Submenu allowing to change the alignment of selected objects
Tile Submenu allowing to tile selected objects
Bézier Point Submenu allowing to edit Bézier points
Text Submenu allowing to edit text
Ellipse Submenu allowing to edit an ellipse

Bitmap Menu Commands

The Bitmap menu proposes the following commands:

Importe 
Bitmap

Import a bitmap from a file

Export 
Bitmap

Export a bitmap or the document to a file

Display 
bitmap

Display a bitmap in a rectangle (the rectangle will be created 
automatically)

Delete a 
Bitmap or a 
Brush

Delete a bitmap or a brush

Generate 
Bitmap

Generate a bitmap from selected objects

Bitmap 
Processing

Apply one or more bitmap processing operations to a bitmap

Fit Sub menu allowing to fit a bitmap to an object (the bitmap will be 
placed in order to be visible inside the object)

Set 
Proportions

Sub menu allowing to set the proportions of an object to match the 
proportions of a bitmap

Place 
Manually

Sub menu allowing to place manually a bitmap

Fit (line) Sub menu allowing to fit a bitmap to an object (the bitmap will be 
placed in order to be visible inside the object). Commands 
are applied to bitmaps used for line rendering.

Set 
Proportions 
(line)

Sub menu allowing to set the proportions of an object to match the 
proportions of a bitmap. Commands are applied to bitmaps 
used for line rendering.

Place 
Manually 
(line)

Sub menu allowing to place manually a bitmap. Commands are 
applied to bitmaps used for line rendering.



Wizard Menu Commands

The Wizard menu proposes the following commands:

Display a 
bitmap in an 
object

Display a bitmap in the selected objects

Create and 
display a 
bitmap from 
an object

Create a bitmap from the selected objects and use it to paint the 
objects

Create a soft 
edge 
shadow or 
mask

Create a soft edge shadow for the selected objects



Page Menu Commands

The Page menu proposes the following commands:

Settings Page Settings
Options Rendering options
Wire Frame Wireframe display
Vectorial Vectorial display 
Real Real display
Zoom In Zoom in with the mouse
Zoom Out Previous zoom level
Zoom Page Full page zoom
Grid Sub menu allowing to control grids.
Guidelines Sub menu allowing to control guidelines.
Show Ruler Display or hide the ruler
Redisplay 
Screen

Refresh the display

Selection Sub menu allowing to change the selection method



Tool Menu Commands

The Tool menu proposes the following commands:

Selection Activate the selection tool
Freehand 
Drawing

Activate the freehand drawing tool

Rectangle Activate the rectangle drawing tool
Ellipse Activate the ellipse drawing tool
Text Activate the text tool




